
 

 

0Undersea Feature Discovery Project (UFDP) Report on SCUFN 32 

Introduction / Background 

Fisheries and Oceans Canada (DFO), is a member of the Geographical Names Board of Canada (GNBC). 
As Canada’s national naming authority, the GNBC has a sub-committee dedicated to undersea feature 
naming - the Advisory Committee for Undersea Feature Names (ACUFN). The Canadian Hydrographic 
Service of DFO, leads this Committee and maintains the Canadian Gazetteer of Undersea Feature 
Names.  

With the availability of new and finer quality bathymetric data, ACUFN wanted to discover new 
undersea features in Canadian waters, in order to generate new name submissions. Thus began the 
Undersea Feature Discovery Project (UFDP). There is no technological investment cost attached to this 
project, other than the human resource. The analysis is based on open bathymetric data and GIS.  

The methodology for discovery was derived from the definitions of the generic terms in the B-6. These 
definitions were used as the IHO standard from which to base the analysis. The project explored how 
features could be detected in bathymetric data, and how that detection could be automated. The 
initial research findings for the discovery of Seamounts and Basins were shared at SCUFN31. Great 
interest was generated as it pertained to:  

1. the potential for automating the discovery of undersea features.  
2. standardizing the settings and thresholds used to discover different features (different 

generic terms) with a desire to build consistency in the result of the analysis.  
 

Project Plan Overview 

The Undersea Feature Detection Project (UFDP) emerged through a series of leadership and research 
opportunities related to the national and international commitments of DFO’s Canadian Hydrographic 
Service (CHS)   

By the time this document was written, a team of intern university students (Shenghao Shi (lead), 
Oliver Farwell, Erin Turnbull and Samir Sellars) had accomplished the following.  

1. Completed the discovery methods for abyssal plains and slope  
2. Fully automated the discovery of seamounts, guyot, and basins  
3. Developed Python script based tools that help to improve the efficiency and effectiveness of 

the undersea feature discovery (see full list below)  
4. Discovery methods for canyons and escarpments have been preliminary established. 

The Undersea Feature Detection Project Plan covers the stakeholders involved, the history of UFDP, 
strategic objectives and detailed discovery workflow for each objective. 

To summarize, the strategic objectives of the UFDP are to create automated tools for the discovery 
of all undersea features listed in the B6, storing the newly discovered features in a reliable database, 
and provide feedback, when applicable, to the Generic Terms Working Group at SCUFN to consider 
for improvement of the generic term definitions in B6. 

 

 

 

 

 



 

Figure 1. briefly explains the steps that are followed during the development of the undersea feature 
discovery tools.  

    

 

 

 

 

 

 

 

 

 

 

 

 

For more information regarding the project plan, please see Appendix I.  

Outcome 

Currently, the research taking place at UFDP, is well aligned with one of SCUFN’s many mandates, in 
this case being, the revision of definitions in B-6.  The progress since SCUFN31 includes:  

 Discovery methods that have been automated as a toolbox for ArcMap: 
o Basins,  
o Seamounts, 
o Guyot (flat-top seamount, as a sub-category of seamount) 

 

 Other discovery methods have been completed, but have not been automated yet:  
o Ridges,  
o Abyssal Plains 
o Sea Channels  
o Shelf 
o Slope 

 

 Discovery methods in progress: Canyon, Escarpment  
 

 Python script based tools that help to improve the efficiency and effectiveness of the undersea 
feature discovery have been developed for: 

o Concave Hull,  
o Directional Buffer,  
o Topographic Position Index,  
o TPI-Slope Classification,  
o Dual-TPI Slope Classification,  
o Filter Elliptical Cones,  
o Identify Pelagic Zones,  
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o Identify Point Nearest Centroid,  
o Identify Zonal Maximum Cells,  
o Local Topography,  
o Nice Raster to Polygons 

For more information regarding the discovery methodologies and automation, please see Appendix II 
to VI.  

Issues about the Current B6 Generic Terms  

During the automation process of Seamounts we experienced the advantages of automating the 
discovery of generic terms in B-6 that contain clear quantitative information. A Seamount is described 
as “A distinct generally equidimensional elevation greater than 1000m above the surrounding relief as 
measured from the deepest isobath that surrounds most of the feature.” That 1000m played an 
important role as the threshold for deciding whether the elevations can be identified as seamounts or 
not. However, the definition of seamount is not perfect since its many aspects are still qualitative, 
which will be further explained in the following paragraphs. In addition, 37 Out of 43of the generic 
terms in B-6 do not have a quantitative figure, associated with the criteria defined in the B-6 
definitions (Figure 2). 

 

 

Figure 2. List of common criteria in the B-6 generic terms definitions. 

 

For instance, B-6 defines basin as “A depression more or less equidimensional in plan and of variable 
extent”. However, there is no explanation about what is considered to be a depression. In our 
discovery method for basin, the analysts used their own interpretation of the word “depression”. The 
resulting method included 1) dividing the entire area of interest into multiple potential basins, using 
a flow accumulation method. 2) Identifying the edge and the centre of each polygon. 3) Comparing 
the average depth of the centre to the edge area. 4) Comparing the average slope value of the centre 
to the edge area. Although we were able to automate the identification, we still made plenty of 
assumptions in our methodology such as what was considered to be flat.  

These assumptions will need to be verified, against a standardized understanding of how to identify a 
“depression”. Otherwise, it would be difficult to expect that a different team of analysts would reach 
the same result. It is required that for consistency, all analysts (or automated scripts) apply the same 
interpretation of the criteria defined in the B-6 definitions (Figure 1). For this outcome to be successful, 
the associated quantitative settings and thresholds will need to be defined.  



This is an example of a definition of “depression”, that could be applied consistently and that could be 
successfully automated:  

The deepest point of a depression, should be no less than 500m, when compared to its surrounding 
isobath, and the steepness of the descending slope should be greater than 5 degrees on average. 
The flat central area should have a relief variance of less than 75m and occupy no less than 66% of 
the total area considered to be a depression.  

Please note that this is just an example, the number is not validated and should not be considered as 
a reference in any ways. In addition, drawn from the experience of our GIS technicians, the definition 
does not always need to be a fixed value, it should allow fluctuation by giving a margin of error and/or 
have localized parameters. 

For more reliable examples of improved definitions, please see the drafted the definitions for abyssal 
plains and sea channels, which have detailed explanations and justifications in Appendix II and V 
respectively. The new quantitative definitions will be created base on 1) existing literatures 2) B6 
generic terms definition 3) methodology parameters 4) data measured from named features from 
GEBCO database 5) data measured from newly discovered features using our discovery methodology 
(with high level of confidence). 

The team is currently continue developing quantitative definitions for undersea features that already 
have their discovery method completed.  

Conclusions 

In our efforts to discover new undersea features in Canadian waters in order to generate new name 
submissions, we have encounter challenges. Applying the definitions of the generic terms in B-6, to 
derive methodologies for analysis and then automation, required that we made some assumptions of 
the quantitative aspect of some descriptions such as “depression”, “steepness” or “slope”.  To have 
the assurance that we have followed, and will continue to follow the international standards for 
identifying generic terms, the assumptions that we have made, would need to be checked, and revised 
quantitative information for all generic terms, would be useful to define. This will be necessary to 
standardize the consistent interpretation of each generic term, and the successful automation of the 
discovery and identification of more undersea features.  

Recommendations  

1. Summarize the list of common terms that may cause ambiguity. E.g. sloping, equal-dimensional, 
shallow, deep, elongated…  

2. Define common terms such as “flat” and “near” with quantitative description such as “elevation 
variation less than 100m” and “no further than 50km away from…” 

 Wording needs to be quantified and standardized. For example, slope equal or less than 0.5 
degree shall be called flat; slope greater or equal to 0.5 but less than 2 degree shall be called 
gently sloping; slope greater or equal to 2 degree but less than 5 degree shall be called 
slope; slope greater than 5 degree shall be called steep slope…  

3. Quantify and standardize the usage of modal verb and frequency related adjectives, such as 
must, should, usually, seldom, etc.  

4. Decide the category of numerical value needed to be standardized for each generic term. E.g. 
basin needs quantitative description for its descending slope minimum in degree, center area size 
to total area proportion in percentage, minimum size in square kilometres. 

5. Consolidate the new definitions for the generic terms that have been revised, and make them 
available to test in the development of automation scripts to aid the discovery of undersea 
features, from bathymetric data. 



The UFDP has developed a few updated, quantitative generic term definitions based on credible 
sources. They are: 

 Abyssal Plain: 
An extensive area larger than 850 km2, that overlies a flat or gently sloping area with 0 - 50 
m of local relief, and is found at a depth between 4000 and 6000 meters. 

 Shelf Break: 
A line defined by the shoreward boundary of an area which deepens at a rate of at least 400 
m per 30,000 m away from shore or has a localized slope of at least 1°. It may include adjacent 
areas which deepen at a rate of 350 m per 30,000 m or have a localized slope of at least 0.5°. 
It must span depths from 250 m to 1,000 m. 

 Shelf: 
The flat or gently sloping region adjacent to a continent or around an island that extends from 
the low water line to the shelf-break. 

 Sea Channel: 
A meandering linear depression with sinuosity typically greater than 1.3, at least no less than 
1.15. Feature need to be no shorter than 150 km, usually occurring on a gently sloping plain 
or FAN where local slope standard deviation is typically less than 0.5 degree, at least no more 
than 0.65 degree. 

The UFDP team will continue working on definition recommendations and make adjustments base on 
the feedback we receive after the SCUFN 32. 

Justification and Impacts  

Standardizing the definitions of generic terms, fits into the objective of SCUFN and benefits our 
understanding about the seafloor.   

Action Required of SCUFN32 

We are willing to have more in-depth presentation of our work to anyone who is interested, either for 
showing or for discussion and updating.  

The UFDP will highly appreciate support and feedback from SCUFN members, we are expecting 
expertise, suggestions, and feedbacks include but not limited to the following fields of study:  

 GIS 

 Topography 

 Oceanography 

 Geology 

 Earth science 

Topics we would like to discuss include: 

 General discussion about discovery methodology, automation, and/or validation  

 Information about undersea feature development, formation, and transformation 

 Undersea feature categorization  

 Definition improvement 

 etc. 
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Overview 

The Undersea Feature Detection Project (UFDP) emerged through a series of leadership and research 
opportunities related to the Canadian Hydrographic Service’s (CHS) national and international 
commitments. To understand those opportunities and the ‘why’ of the UFDP, some context is 
required.  

 

Stakeholders 

Representing DFO, CHS is an official federal member of the Geographical Names Board of Canada 
(GNBC) whose board consists of Federal, Provincial, and Appointed members. As Canada’s national 
naming authority, the GNBC has a sub-committee dedicated to undersea feature naming - the 
Advisory Committee for Undersea Feature Names (ACUFN). CHS chairs ACUFN, houses the secretariat, 
and maintains the ACUFN website. ACUFN is composed of members from the GNBC secretariat, CHS, 
private industry, and academia. It reports annually to the GNBC, and handles all naming requests or 
inquiries related to undersea features.     

On the international level, undersea feature naming is handled through the Standing Committee of 
Undersea Feature Names (SCUFN) at the International Hydrographic Organization (IHO). CHS 
represents Canada as a member at SCUFN, and serves as an observer and advocate for Canadian 
interests and submissions. The IHO jointly supports the General Bathymetric Chart of the Oceans 
(GEBCO), which has as a project Seabed 2030 – the goal of mapping all ocean floors by 2030.  
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History 

All of these organizations and sub-committees have a common shared goal of data standardization 
and interoperability. ACUFN aims to harmonize all generic terms (official names for undersea feature 
types) with the IHO. The IHO aims for an improved data structure for GIS web map services and the 
addition of all generic terms to the IHO Geographic Information Registry. National hydrographic 
organizations (i.e. Canada) are creating and contributing more bathymetric data for projects like 
Seabed 2030, requiring an international standard for categorization, naming, and sharing. In 
September 2016 at SCUFN’s 29th meeting (SCFUN29), the Undersea Feature Name Project Team 
(UFNPT) was created to address these issues. Along with exploring the creation of an S-100 compliant 
data model which would set a new and flexible international standard for undersea feature names 
(UFNs), the UFNPT would work closely with the Generic Term Working Group (GTWG) to harmonize 
generic terms.  

The UFDP began in the context of these moving parts. In light of new and finer quality bathymetric 
data, ACUFN wanted to investigate whether new undersea features could be discovered in Canadian 
waters in order to generate new name submissions. CHS headed that research and began the UFDP 
as a co-op project. As one of ACUFN’s priorities was harmonizing with IHO generic terms, the B6 
Generic Terms list (IHO standard) was applied to the research. Using characteristics defined in the B6 
definitions, the project explored how features could be detected in bathymetric data, and how that 
detection could be automated. CHS’ position on SCUFN allowed the opportunity to bring the research 
findings to an international level at SCUFN30. Great interest was generated from the UFDP 
presentation as it pertained to 1) benefits of automation in terms of international standardization, 
and 2) issues with the ambiguity of generic terms and challenges that presents to automation and 
standardization. The research of the UFDP exposed the weakness of the current generic terms as they 
apply to standardization, and in order to achieve the goal of an international data model standard for 
UFNs, the UFNPT must incorporate the required changes of the generic terms into the new data model 
(changes the GTWG must confirm). After SCUFN30 interest in the UFDP was strong in both the UFNPT 
and the GTWG. 

As described here, the interests of ACUFN and SCUFN are well aligned and continue to generate 
demand for the UFDP research. The following sections will outline the main areas of focus, strategic 
objectives, and deliverables.  

 

Strategic Objectives 

 

The strategic purpose of the UFDP is to create methodologies to automate the discovery of undersea 
features from bathymetric data. This will provide ACUFN with the possibility for new name 
submissions, as well as increase efficiency in data processing. The UFDP research has broader interest 
from SCUFN and the UFNPT, and so objectives can be aligned. The strategic objectives of the project 
are as follows; 

1) Create reliable tools for the discovery of undersea features listed in the B6 Generic Term list; 

2) Create a bank of newly discovered, unnamed undersea features; 

3) Provide feedback on B6 generic terms to the GTWG regarding their applicability to 

standardization and automation; 



4) Provide feedback to the UFNPT regarding generic term definitions and impacts or 

modifications that could be applied to the new S-100 Undersea Feature product 

specification. 

 

 

Objective 1. Reliable Tools 

 

Objective 1 is the core research goal of the project. In order to confidently identify undersea features 
in current and future bathymetric data sets, reliable, validated tools must be developed. This 
development can follow a similar cycle for the various undersea feature. Figure 1 below illustrates the 
recommended development cycle.   

 

    

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 1. Detection Methodology 

Several examples of this already exist thanks to prior research done on Seamounts, Guyots, Basins, 
Ridges, and Channels. Methodologies will change from feature to feature as unique specs are 
accounted for using the B6 definitions. Some definitions have quantifiable qualities that make them 
easily measured, i.e. seamounts must be at a depth of at least 2000m. However, some definitions have 
vague and qualitative descriptions. Interpretation of these and the translation of them into measured 
detection methods requires creativity and testing.  

Deliverable: Preliminary detection methodology for a new undersea feature 

 

Step 2. Testing 

Once a methodology is developed it must be tested and refined. Visual validation can be performed 
to check results. For this purpose training data should be identified though visual check should suffice. 
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The main goal is to confirm that the methodology is identifying the correct features, and that small 
fragments and residual features are removed.   

Deliverable: Tested methodology and relatively accurate output features 

 

 

Step 3. Automation 

With a methodology working, it should be compiled into an automated environment such as ArcGIS 
Model Builder, or a python script. Automating will force qualitative questions to be answered and 
recorded, as well as remove variability in analysis decisions common in a user controlled workflow. 
Output should be a workable raster or polygon feature layer of identified features.  

Deliverable: Automated script or model of the new undersea feature detection methodology  

 

Step 4. Validation 

This step is crucial in order to report with confidence the validity of the automated output. A 
methodology must be developed that will determine the statistical confidence of the outputs, and 
which can be applied to all the models. Training data must be identified or created for this purpose. 
This will be an iterative process and, will be the final refining of the model in order to generate 
accurate results. Should validation expose flaws in the methodology, Step 1 should be revisited. 
Accuracy of the models must be recorded, and should be tested with differing data and parameter 
modifications.  

Deliverable: Final automated detection model/script, statistically tested and validated 

 

Step 5. Recommendations 

With the completion of a detection methodology, recommendations should be made, if applicable, on 
how to improve the B6 Generic Term definition of the feature. Definitions are notoriously vague and 
qualitative, leaving arguably too much room for interpretation and subjectivity. Hard numbers 
generated for the models or discovered in the research can be recommended. Lessons learned from 
the research and the interpretation of the current term can be added. Any information that can be 
useful for the improvement and increased specificity of the B6 Term should be included in a 
recommendation.  

Deliverable: short document outlining recommendations that can be passed on to the GTWG and 
UFNPT 

 

Step 6. Packaging 

As a final step the completed automation script must be wrapped in a shareable/transferable package. 
This must include two main portions; supporting documentation and tools. 

Supporting documentation should include a final report outlining methodology, validation output, and 
a how-to-guide for running the tool itself and interpreting the outputs. 

The tool should be a simplified interface to the automation process. If it’s a script, requests for path 
changes and optional parameters should be clear and kept to a minimum (parameters that effect 
output quality should be hardcoded). If the tool is a model, again, clear and minimal steps must be 
outlined. Variability in output is counter to standardization (as well as multiple runs by the same user). 



 

  

 

 

Objective 2. Discovered Features Database 

 

The ultimate goal of the UFDP is to generate newly discovered undersea features to name in Canadian 
waters. The newly discovered features from Objective 1 will therefor need to be stored in a database 
that facilitates their sharing and access. Submission of these features to GEBCO requires specific 
attribute data and correct feature geometries.  

 

Step 1. Project and Database Creation 

An ArcMap project and geodatabase should be created to store and standardize the unnamed 
features. The B6 document specifies the accepted geometry of submitted features, as well as required 
attribute data. The geodatabase should be created using these requirements in order to populate with 
accepted standards. The project should facilitate the discovery and selection of undersea features.   

 Deliverable: standardized geodatabase created for various undersea feature geometries.  

Step 2. Populate Database 

Although the scripts will be refined and the outputs will be validated, the features added to this 
database should be thoroughly vetted as they are theoretically ready for submission. However the 
naming process looks, the point, lines, and polygons in this database are the authoritative source for 
the unnamed features. Script outputs for the varied features must validated, then imported to the db 
under the correct geometries, and the required attribute data either entered or calculated for each 
feature. The db must be formatted in a way to facilitate submissions. A simple export of features 
should meet all GEBCO submission requirements.  

Deliverable: database populated with all discovered undersea features, accessed via an organized map 
project.   

 

 

 Objective 3. GTWG Feedback  

 

This objective should be covered through Step 5 in objective 1. The Generic Term Working Group is 
actively reviewing B6 Definitions and has already taken much interest in the UFDP. Findings from 
research and development should be composed in a document and submitted to the group as 
recommendations that can improve automation and standardization. Both goals go hand in hand as 
standardization leans towards quantifiable characteristics (min height, max width, etc), which apply 
well to automation and scripting.  The recommendation feedback can be submitted as new features 
are identified, though the format should be standardized for submissions.  

Deliverable: A single report or series of reports outlining improvement recommendations to the B6 
Definitions.   

 



 

Objective 4. UFNPT Feedback  

 

The development of a new S-100 Undersea Feature product specification is underway. A primary goal 
in moving to a new product spec is data interoperability and flexibility. The new spec allows for 
additional attributes which will meet the requirements of various user types (mariners, scientists, etc). 
As research is underway for both the B6 Definitions and the Undersea Feature model itself, it only 
makes sense to provide feedback between both. Any research findings or 
modifications/enhancements to the data model that could result in improvements to standardization 
or automation should be included in a report to the UFNPT.    

Deliverable: A single report outlining improvement recommendations to the UFN Data Model for new 
S-100 Spec. 

 

 

Wish List 

 

Packaging – Once all automation scripts are developed and finalized, the creation of a single interface 
for UFN discovery would be favorable. This could come in the form of an Arc Toolbox. All automation 
scripts could be merged into a single tool where users select the feature to discover, parameters are 
entered, outputs are chosen, and with one click the automation begins.  

 

 

Conclusion 

 

This project plan should serve as a thorough, high level understanding/vision for the UFDP. Timeline 
and task lists must be developed according to current work availability and skills. Development will be 
variable as work resources are subject to change. For any questions, please consult the contacts listed 
at the beginning of the documents.  

 

  



Appendix II 

Abyssal Plains Report 
By: Samir Sellars  

 

IHO definition: An extensive, flat or gently sloping region, usually found at depths greater than 

4000m. 

- IHO also defines abyssal hills as an isolated elevation within the abyssal plains 

o Abyssal hill: An isolated small elevation on the deep seafloor. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Interpreting the IHO (B6) definition: 

*Green is a recommendation* 

An extensive, flat or gently sloping region, usually found at depths greater than 4000m. 

- “An extensive”: Extensive is a difficult and broad word to apply when there is an extreme 

variability in the size of established abyssal plains. There is documentation in the literature 

of plains that are hundreds of thousands km2, while some only cover an area of 850 km2 

(Weaver et al. 1987). It was decided the smallest GEBCO established abyssal plain should be 

used as a minimum size to qualify. Although, a much larger minimum size of 50,000 km2 

could be used to simplify the data. A minimum size should be created to clear up any 

confusion on the accepted size as there is a large variability in the literature. 

- “flat or gently sloping region”: Abyssal hills are talked about in the B6 and are defined above 

as small elevations in the seafloor. It was assumed gently sloping regions could be 

considered abyssal hill areas. The definition of abyssal hills was non-specific and to further 

understand, the literature was consulted and revealed sources stating that an abyssal hill 

could typically rise from 300 to 1000 meters (Harris et al. 2014). However, in many examples 

of GEBCO established abyssal plains, there is no clear indication that plains were established 

with a maximum amount of relief allowed. Therefore, it is difficult to strictly classify abyssal 

areas and how you classify abyssal areas based on the local relief can drastically change the 

size of identified areas. Flat or gently sloping regions should be defined further within the 

IHO definitions and local relief ranges (Roughness levels) should be stated for different types 

of abyssal areas. 

- “usually found at depths greater than 4000m”: The word “usually” in this part of the 

definition allows for too much subjectivity. The literature and examples tend to state abyssal 

plains can only be found below 4000 m as a general rule. Some examples in GEBCO, such as 

the Canadian Abyssal Plain in the north, do not contain any areas of depth below 4000 m. 

Furthermore, one study states that there are major differences between areas of depth at 

4000 meters that differentiate true abyssal plains from other shallower areas. These major 

differences are attributed to varying hydrodynamic energy between the different depths. 

Generally shallower depths (Continental slopes) are found to contain increased movement 

of sediments (Hannides et al. 2003). The literature states areas deeper than 6000 meters are 

not considered to be part of the abyssal plain. However, this is not specified at all within the 

IHO definition despite 6000 meters of depth being an agreed upon depth limit in the 

literature. Therefore, a defined parameter should be given within the definition that states 

the minimum and maximum depths. 

 

 

 

 



Methodology in ArcMap: 

*Blue = Assumption made to aid detection* 

1. Assign a coordinate system to the working layer 

(WGS_1984_Web_Mercator_Auxiliary_Sphere was used).  

2. Raster calculator: Used to eliminate all areas that are too shallow or too deep to be an 

abyssal plain.  

a. Assumption: The shallowest depth considered to be part of the abyssal area was 

4000 meters and the deepest depth was considered to be 6000 meters. The 6000 

meters value was taken from various literature that all agreed on 6000 meters is the 

deepest part of abyssal plains with anything below 6000 meters being classified as 

the Hadal zone (Harris et al. 2014) 

3. Buffer the outcome of the previous step by 5 cells from the area that was identified to be at 

abyssal plains depth. This will generalize the data and remove any peaks within the raster. 5 

cells is 9 kilometers. This parameter was chosen as most points of elevation in abyssal plains 

are considered abyssal hills (Abyssal hill: An isolated small elevation on the deep seafloor), 

with some seamounts included. The buffer removes the peaks (A conical or pointed 

elevation at the summit of a larger feature according to the B6 definition) of seamounts that 

usually rise above 4000 meters of depth. Additionally, 9 kilometers is large enough to 

smooth out the edges of the plain.  

a. Assumption: 9 kilometers is small enough of a value to smooth out the data and 

eliminate peaks. This number was chosen through trial and error and was not based 

on any literature. 

4. Use the reclassify tool and render all parts of the buffered raster that do not lie on approved 

depth to have their values changed to NoData. 

5. Use the Extract by Mask tool to input the bathymetric data into the buffered raster that was 

reclassified. In other words, the raster mask inputs the data from the bathymetry into the 

remaining buffered raster (Viable raster).  

6. Use the focal statistics tool and input the bathymetry from the buffered raster to measure 

roughness of surface. The sample size should be 25 by 25 cells. This means the area tested 

was 2025 km2. Standard deviation will be used to detect differences in elevation in the local 

area. The output will be classified with breaks at 50, 300, and 300+. The first classification is 

between 0 - 50 meters and is set to identify areas that are most likely abyssal plains. Areas 

that are classified between 50 and 300 meters can be considered to contain abyssal hills and 

may or may not fit into the IHO definition. The next classification is a standard deviation of 

over 300 meters and are areas that contain larger hills or seamounts.  

a. Assumption: These ranges of classification are more conservative than other papers 

that attempted to also classify abyssal areas using a similar method. The 

methodology was created in an attempt to follow the IHO definition as closely as 

possible while also ensuring abyssal plains established by GEBCO are located. The 

existing GEBCO undersea feature database was used to test the methodology. 

GEBCO data does not differentiate between abyssal plains, abyssal hills and abyssal 

mountains. Therefore, a conservative abyssal plains range was selected in an 

attempt to be as accurate as possible in respect to the data the methodology was 



based on. The abyssal zone classifications from other studies can be found in the 

literature (Harris et al. 2014 ; Dekavalla and Demtre. 2017) 

7. Use raster calculator to divide the three regions into three separate fields based on the 

three classifications between plains, hills and mounts. 

a. The raster hills area requires this statement: output = ("Ex.Raster" >=50) & 

("Ex.raster" <=300) 

8. Reclassify the newly cut out raster calculator output for each abyssal level 

9. Use the raster to polygon tool to convert the raster layers to polygons. 

10. Create new fields that contains area in km2 for each polygon. Ensure the new field is a 

double. 

11. Delete the polygon sizes that are too small. The current minimums tested were 850 km2 as a 

small scale and 50,000 km2 as a large scale test. These deletions were only performed to the 

hills and mount zones. The deletion was done by editing and selecting all the polygons that 

do not meet the minimum size threshold and then deleting them. A smaller minimum size 

detects many more new plains and is capable of finding the smallest GEBCO abyssal plains. 

The 50,000 km2 restricts itself to only finding larger abyssal plains, but it also removes a lot 

of possible “noise” from the plains found. 

a. Assumption: The 50,000 km2 minimum size was chosen originally through trial and 

error to fit the methodology. A final parameter for this detection methodology will 

require the IHO to have a quantitative definition used to define how extensive a 

plain must be. 850 km2 was eventually chosen as it was the smallest GEBCO 

established abyssal plain size.   

12. Use the union tool with the parameter “Gaps allowed” unchecked. This will fill in the 

remaining holes within the polygons. Then use the dissolve tool to combine the fill polygons 

with the larger polygon.  

13. The resultant layers represent the three abyssal areas as plains, hills and mounts. It is likely 

that the plains area fits the IHO definition and less likely the other areas fit the IHO 

definition.  

 

 

 

 

 

 

Results of the Methodology  
Running the methodology at a world scale with a minimum area threshold of 850 km2 yields 831 

separate abyssal plains. Some of these separate abyssal plains are very close together and may be 



considered a single plain when visually assessed. 17 abyssal plains from the GEBCO database were 

located and had an overlap between the point and the plains polygon generated. 12 GEBCO abyssal 

plain points were slightly off the plains polygon generated by under 100 km. 9 GEBCO abyssal plains 

areas were overlaying hills or mounts relief zones that were at least 100 km away from the closest 

plain. 14 abyssal plains from the GEBCO database were not identified by the methodology due to the 

plains not being deep enough. A visualization of the results can be seen in Figure 1. 

Running the methodology at a world scale with a minimum area threshold of 50,000 km2 yields 65 

separate abyssal plains. 12 abyssal plains from the GEBCO database were located and had an overlap 

between the point and the plains polygon generated. 5 GEBCO abyssal plains points were slightly off 

the plains polygon generated by under 100 km. 18 GEBCO abyssal plains areas were overlaying hills 

or mounts relief zones that were at least 100 km away from the closest plain. 17 abyssal plains from 

the GEBCO database were not identified by the methodology due to the plains not being deep 

enough. 

These tests were performed on the NOAA ETOPO1 Global Relief Model which is 1 arc-minute. A cell-

registered georeferenced tiff was used that was assigned the 

“WGS_1984_Web_Mercator_Auxiliary_Sphere”. The data can be found:    

https://www.ngdc.noaa.gov/mgg/global/global.html 

 

 

 

 

 

 

 

 

 

 

Figure 1. These polygons were generated from running the methodology on a world bathymetry 

dataset. 831 separate abyssal plains were identified, 17 GEBCO established abyssal plains had direct 

overlap between the generated polygon and established point, 12 GEBCO points were under 100 km 

away from the nearest generated polygon, 9 GEBCO points overlaid regions that may or may not be 

classified as an abyssal plain (too much local relief) and 14 points were not detected as they overlaid 

areas that were typically too shallow 

Discussion of Methodology and Current Issues   
The 850 km2 minimum size was able to detect an increased amount of GEBCO abyssal plains than the 

50,000 km2 . The smaller threshold was more accurate than the larger threshold as more GEBCO 

abyssal plains were found, along with identifying GEBCO abyssal plains within 100 km of a generated 

polygon. The smaller size threshold may potentially allow for the naming of many new smaller 

abyssal plains. Alternatively, many of the smaller abyssal plains detected are closer to larger abyssal 

https://www.ngdc.noaa.gov/mgg/global/global.html


plains and a decision would have to be made on when to associate two separate plains. A larger 

agreed size would present many less new abyssal plains, but would also contradict current GEBCO 

recognized abyssal plains. 

The largest issue in the current methodology is the minimum size needed to be considered an 

abyssal plain. Abyssal plains have been identified to be as small as 870 km such as the Barents 

abyssal plain. This plain is mentioned in the literature and is in the GEBCO Gazetteer (Weaver et al. 

1987). Plains have also been identified to be as large as 1,000,000 km2 such as Angola abyssal plain 

which is also in the literature and the GEBCO Gazetteer (Weaver et al. 1987). An example of using a 

smaller minimum threshold can be seen in Figure 3 which uses a minimum of 850 km2. The lower 

minimum allows for the detection of previously too small to detect abyssal plains such as the Blake 

abyssal plain. A lower minimum also permits for “noise” within the identified plains. For example, 

“A” on Figure 3 is not an identified abyssal plain and could potentially be a new abyssal plain, or part 

of either Blake or Hatteras.  

Three areas of the abyssopelagic zone are identified when using the methodology. The three areas 

are plains (0-50 m standard deviation of relief), hills (50 – 300 m standard deviation of relief) and 

mountains (300+ m of standard deviation). Each of these areas could be considered part of the 

abyssopelagic zone depending on the interpretation of the current definition. Therefore, the size of 

abyssal plains can drastically change depending on the interpreters subjectivity and this presents a 

problem concerning the accuracy of the methodology. An example of this can be seen in Figure 2 as 

there is a discrepancy between the size of the plains detected by the methodology verse the size 

stated in the literature. Although, the author had stated that the size estimates in the paper have a 

large margin of error (Weaver et al. 1987). Based on testing the methodology from the GEBCO 

database, it is most likely that the first classification of 0 – 50 meters will be the most accurate and 

useful range. The 0 – 50 m classification is the range that will be used to classify proposed abyssal 

plains.  

Currently, the B6 definition includes the phrase “Gently Sloping” inferring that a specific slope can be 

associated to this term. The average slope was taken from each of the GEBCO identified abyssal 

plains. Polygons that overlapped with GEBCO points and polygons that were less than 100km away 

from a GEBCO point were used to calculate average slopes of each abyssal plain. Please refer to 

abyssal statistics spreadsheet to see the average slope of each plain. The average slope between 29 

GEBCO established plains was found to be 2.667857o with a standard deviation of 2.111188 o. The 

minimum value reached was 0.655418 o and the maximum average slope reached was 8.024422 o. A 

large difference can be noted between these values and therefore a specific slope value was 

excluded from the final definition and the methodology.  These slope values were calculated based 

on the 850 km2 minimum area threshold. 

The choice to sample roughness at a scale of 2025 km2 was not specifically chosen according to 

literature as it was a value selected due to trial and error. Sample area size for roughness is directly 

related to the agreed upon minimum size. A smaller minimum size would use a smaller area to 

sample roughness. A new definition with a minimum size will allow for this parameter to be assigned 

an appropriate value. If a testing size of 850 km2 is eventually agreed upon, it may be beneficial to 

decrease the sampling of the roughness area.  

A clear and quantitative definition must be agreed upon to remove subjectivity from the detection 

of undersea features.   

 



 

 

 

 

 

 

 

 

 

 

 

 

Figure 2. Hatteras Abyssal Plain is visualized above and has an area in the literature of 460,000 km2 

and verses the methodology which calculated the area to be 594,000 km2. (Performed with a 

minimum abyssal plains size of 50,000 km2) 
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Figure 3. Hatteras, Blake and Nares abyssal plains are visualized above. All three plains are present 

in GEBCO and literature. “A” is an example of a new abyssal plain. (Performed with a minimum 

abyssal plains size of 850 km2) 
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Revised Definitions: 

A revised definition is suggested to allow for an effective method to discover new abyssal plains and 

to ensure that all currently identified abyssal plains are actually abyssal plains. The most effective 

definition will define all parameters of the undersea feature and will leave no phrases up for 

subjective interpretation. A revised definition should be quantitative and have exact parameters for 

each attribute of the feature.  

Ideally, all IHO definitions would undergo a change and become increasingly quantitative to facilitate 

the validation of current features and the discovery of new ones. The goal to map the ocean floor 

will arguably only be achieved if the features being mapped are easily identifiable and have no 

overlapping attributes with another feature. Overlapping attributes will cause confusion and 

discrepancy between groups attempting to classify undersea features, which will ultimately slow the 

discovery process. It can also be noted that papers that attempt to classify undersea feature have a 

specific set of defined attributes assigned to each feature to allow for easy classification and overlap 

(Harris et al. 2014 ; Dekavalla and Demtre. 2017). 

The following definitions are examples that are suggested to increase the quantitative values within 

the IHO abyssal plains definition. Suggestion #1 includes the quantitative values within the 

definition, while suggestion #2 almost completely retains the initial definition while only defining 

specific keywords below.  

Current Definition:  An extensive, flat or gently sloping region, usually found at depths greater 

than 4000m. 

Suggested Definition Option #1: 

An extensive area larger than 850 km2, that overlies a flat or gently sloping area with 0 - 50 m of local 

relief, and is found at a depth between 4000 and 6000 meters 

Suggested Definition Option #2: 

An extensive, flat or gently sloping region, usually found at depths between 4000 and 6000m. 

Extensive: 850 km2 or larger  

Flat or gently sloping area: (0 - 50 m of local relief) 

 

Justifications:  

- 850 km2  was chosen as the minimum size as it is the smallest abyssal plain identified in the 

literature and is present in the GEBCO undersea feature database (Weaver et al. 1987). A 

larger size will detect less new abyssal plains, but, will detect less false positives. A smaller 

minimum size will detect new abyssal plains and may detect false positives. Ultimately, 850 

km2 was chosen as it was shown to be more accurate when identifying already established 

abyssal plains.  

- No value was given for slope as the current minimum slope, maximum slope and average 

slope does not help identify abyssal plains. 

- 0 – 50 meters of local relief or relative surface roughness was chosen to be  the parameters 

for flat or gently sloping which is based on other papers that have attempted to perform 



similar undersea classifications. A more conservative roughness scale was chosen than other 

papers as trial and error revealed 0 – 50 meters to be accurate concerning GEBCO data 

(Harris et al. 2014 ; Dekavalla and Demtre. 2017).  

- A depth of 4000 – 6000 meters was chosen partly based on the 4000 meter parameter given 

by the B6 and partly chosen based on the literature that agreed abyssal plains can only be 

found at a maximum of 6000 meters (Angel. 1997). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Possible Opportunity to Name New Abyssal Plains: 

If the current parameters are agreed on from the revised definition, 831 potential abyssal plains 

could exist. This is a large number and seems unlikely that this many individual plains could exist. 

Many of these plains are almost adjacent and may not be considered a separate entity. A reasonable 

solution to this would be to associate and consolidate all plains that are only 100 km apart from each 

other. When discussing distance in the scale of abyssal plains, 100 km is a trivial distance for another 

plain to be considered a completely unique entity. Therefore, it is proposed that all newly generated 



abyssal plains polygons under 100 km apart should be grouped and identified as a singular plain with 

multiple parts, or perform a visual check to connect the parts as seen fit.  

This test was performed in ArcMap on the data from Figure 1 and yielded a more realistic number of 

249 abyssal plains. Many areas had considerable large groups of scattered small plains that were 

grouped together into one entity as seen in Figure 4. Additionally, there were many larger plains that 

had small abyssal plains nearby that the grouping also fixed as seen in Figure 5.  

Already established separate abyssal plains may become snapped together to become a single plain. 

A visual check to remove these occurrences manually would be necessary.  

 

Figure 4. Previously unidentified abyssal plains area that was extremely fragmented with the 

majority of the fragments being within 100 km of each other. This was performed with a minimum 

abyssal plains size of 850 km2 with the coordinates (-118,-2) in the centre of the image for 

reference. 

 



 

Figure 5. Wedell abyssal plain can be seen with some fragmentation on the boundary. These 

fragments can be snapped together to allow for a combined abyssal plain. All the small fragments 

in this image are under 100 km away from Wedell abyssal plain and would be associated with 

Wedell once combined. This was performed with a minimum abyssal plains size of 850 km2. 

 

 

 

 

 

Wedell Abyssal Plain 
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Appendix III 

Detection Methodology of Undersea Basin 
Shenghao Shi 

Summary 
 

This report is about using GIS to detect undersea features. The platform used to conduct analysis is 

ArcMap 10.6 with spatial analyst extension. The undersea feature chosen for this project is the 

basin, whose definition is acquired through B-6. This is the second feature whose detection has been 

automated by CHS. The first one is seamount and the automation process is developed by Oliver 

Farwell. 

 

Background 
 

B-6 is the standardization of undersea feature names, one of the IHO publications. B-6 contains the 

guideline for the standardization of undersea feature names, undersea feature name proposal, list of 

undersea feature generic terms and definitions etc.  

Within the list of undersea feature generic terms and definitions, there are 43 generic terms and 17 

generic terms used for harmonization with other gazetteers and definitions. The focus of this project 

is on the former.  

Among all the generic terms, most majority of them are rather descriptive and general. Previously, 

my colleague Oliver has made a successful attempt to analyze a feature that has a clear numeric 

definition—seamount. This time, I tried to quantify a qualitative description i.e. basin.  

 

Figure 3. B-6 definition of a seamount 

 

Figure 4. B-6 definition of a basin 

For this project, the bathymetry data used is the ETOPO1 (bedrock) dataset from the National 

Oceanic and Atmospheric Administration (NOAA) with 1-minute resolution (about 1.8km). The data 



is acquired through this site: https://maps.ngdc.noaa.gov/viewers/wcs-client/. Reason for choosing 

this data source is simply its accessibility. The analysis can be redone easily on a database with finer 

resolution. 

Definition Analysis 
According to the B-6 definition, a basin is defined as “a depression more or less equidimensional in 

plan and variable extent”. From this definition, we can conclude the following key features of a 

basin:  

1. It should be a depression, which means the center area should be lower than the edge area. 

2. Also, the central area should be flatter than the surrounding of the basin.  

3. It should be equidimensional, which means that the shape of the basin should, more or less, 

resemble an ideal round shape.  

Analysis Process 

1. Basic Setting  
 

To begin with, the ETOPO1 dataset includes the bathymetry of the entire earth’s surface. The first 

step is to extract the Canadian water using the NOAA website, see figure 3.  In this step, I 

deliberately chose a large area because the analysis does not base on the entire area. Having a large 

enough base dataset allows me to find an area of interest easily.  

To extract the desired area, use either the select with a rectangle or the select with coordinate tool 

located at the top left corner of the website. For the record, the area chosen in this step is: 65.496 

North, -122.094 East, 40.197 South, and -167.756 West. Then go to the bottom of the site, choose 

ETOPO1(ice) as the layer, GeoTiFF as the output format, then click on “click here to download” to 

download the data. 

Start ArcMap, create a new blank map, load the tiff file download from the last step. Then as we can 

see the tiff file include both land and ocean bathymetry. To extract the ocean area only, we need to 

enable spatial analyst extension. Go to Customize> Extensions> Spatial Analyst to turn it on. Next, 

use Extract by Attributes tool, set the tiff file as input raster, and use "Value" < 0 as the formula. The 

output will be a raster where elevation less than 0 meters. See figure 4. 

However, the result still contains too much data. To be able to reduce unnecessary computing time, I 

chose a smaller area of interest. To do so, open editor toolbar> editor> start editing> construction 

tools> rectangle to draw a recently in the desired area, which will be called the area of interest (AOI) 

in the rest of the passage. The relative location is shown in figure 5. Next, use Clip tool under System 

Toolboxes> Data Management Tools> Raster> Raster Processing> Clip. Use the bathymetry tiff file as 

Input Raster, use the AOI created in the last step as Output Extent. The output should be the 

bathymetry of the AOI. 

By this step, the preparation is completed. The rest of the analysis will be based on the AOI only.  

 

https://maps.ngdc.noaa.gov/viewers/wcs-client/


 

Figure 5. Extracting data from ETOPO1 database, NOAA 

 

Figure 6. Before and after extract by attribute 



 

Figure 7. Relative Location of the area of interest 

2. Basin Division 
 

In this step, we will use the hydrology tool to divide the AOI into basins.  

First, go to System Toolboxes> Spatial Analyst Tools> Hydrology> Flow Direction. Use the clipped AOI 

bathymetry as input surface raster, leave all setting as default and run the tool. You will generate an 

output looks like figure 6. Next, run the basin tool (also located under Hydrology). Use the flow 

Figure 9. Flow Direction output for AOI 
Figure 8. Basin tool output for AOI 



direction output as Input flow direction raster, the result will be a raster delineating all drainage 

basins.  

As we can see, the basin size varies a lot. But generally speaking, the size of basins usually stays 

within the range of 25km -125km in terms of diameter. If we need to enlarge the size of each basin, 

there is a method suggested by Oliver Farwell—use the fill tool. This tool allows us to fill sinks in a 

surface raster to remove small imperfections in the data. Figure 8 is a simple illustration of how this 

tool works. For more detailed information, see the tool help in ArcMap. 

To apply this method, follow the following steps: open fill tool under: Spatial Analyst Tools> 

Hydrology> Fill. Use the bathymetry raster as the input surface raster, enter Z limit, which is the 

maximum elevation difference between a sink and it's pouring point to be filled. The greater the Z 

limit, the bigger the size of the basin is, meanwhile, the less accurate the bathymetric data are. After 

the fill, use the output of the fill as your new bathymetry raster. Repeat the step of flow direction, 

then basin tool. Figure 9 presents the basin tool output of the same AOI when the bathymetry is 

filled by a Z limit of 100 meters. 

The rest of the analysis is based on the unfilled bathymetry. But if desired, the same step can be 

followed using filled bathymetry.  

After getting the basin layer, use Conversion Tools> From Raster> Raster to Polygon tool to convert 

basin raster to a polygon layer (Use basin raster as input raster). Thereby getting the vector shapefile 

of the basins, which will be used to conduct the next step of the analysis.  

 

3. Identify Central and Edge Area  
 

Figure 10. How fill tool works 

Figure 11. Basin tool output using filled bathymetry, fill Z limit = 
100m 



The objective of this step is to determine what should be categorized as the central and edge area 

for each basin in order to compare the center and the edge of each identified basin.  

To begin with, we need to enable a hidden tool called the buffer wizard to identify the edge area. 

Open the Customize menu and choose to Customize mode. Select the Commands tab, then enter 

the text ‘buffer wizard’ in the ‘Show commands containing’ box. Drag the tool to a toolbar (the Tools 

toolbar is suggested).  

Next, we need to open the attribute table of the basin shapefile layer. Go to table option> add a 

field, and add five new fields called area, perimeter, Buffer_5, Buffer_3, and Buffer_2 respectively, 

the type for all five should be set as a float. Once the new fields are ready, right click on the title of 

area and perimeter, select calculate geometry, choose yes on the warning window and calculate the 

area and the perimeter respectively. Please make sure the unit used is consistent.  For the rest of the 

three fields, what we want to achieve is to calculate the length that is proportional to the surface 

area and the perimeter of each basin. So for these three fields, we use field calculator instead of 

calculating geometry. The formula used should be [Area] / [Perimeter] / 2or3or5 (or another 

number) to generate 3 buffer distances for each basin (reason for choosing the number will be 

explained by the end of this section). 

Now, open the buffer wizard, choose the basin shapefile layer as the features of a layer, and click 

next. Choose Based on a distance from an attribute choose one of the three buffer distances we 

calculated in the last step, make sure the distance units are consistent with the unit used when 

calculating the three buffer distances, click next. Select no for dissolve barriers between, select only 

inside the polygon(s) for the second option, and then click finish. Repeat the above steps using all 

three buffer distances. The result should resemble figure 11.  

Figure 12. Buffer Wizard tool loaded into the toolbar 



 

After identifying the edge area for each basin, the next step is to identify the centers. To do so, 

following the steps below: turn on the attribute table of the basin shapefile layer, go to table 

option> add a field, and add two new fields called X and Y, use Float type for both fields. Right, click 

on the cell X and cell Y, choose to calculate geometry > X coordinate of the centroid and Y coordinate 

of centroid respectively. Make sure the unit used are consistent. Go to table option again, choose 

export, click OK, select yes for the next pop out window to add the table to the map. Find the table, 

right-click it in the table of contents panel then select Display XY data. Use X as the X Field and Y as Y 

Field, which should be the default, then click OK. As the result, a new point layer will be added to the 

map, which is the mathematical center of the basins. Next, go to Geoprocessing> Buffer, set the new 

point file as input features. Since the point file is derived from the table that contains the data we 

use to create the rings of edge, this layer contains the same data. So in this step, when choosing the 

buffer distance, select Field, and choose the appropriate buffer distance. The output combined with 

the result of the last step should resemble figure 12.  

There is no absolute correct option in terms of choosing the buffer distance when calculating the 

edge area and the center area, which is why there are three buffer distances. Further research can be 

done on known undersea basins to figure out that on average, how many percent area on the edge 

of a basin descends most significantly. For example, if we find out that on average, the first one-fifth 

of the radius near the basins edge witnesses the sharpest greatest in elevation and has the sharpest 

slope. Then we can determine that the constant we used when calculating the buffer distance should 

close to 5.  

Figure 13. Result of inner buffer using three buffer distances 



 

Or, alternatively, we can experiment with different constants within an area with known undersea 

basins. And see what constants output the most precise result for detection undersea basins. 

For the rest of this project as well as figure 12, both center point buffer area and edge buffer area use 

buffer distance of Buffer_3. i.e. the value of [Area] / [Perimeter] / 3. 

4. Slope and Depth Value  
 

To compare the center and the edge, we need to introduce slope and depth value from the 

bathymetry.  

First, go to Spatial Analyst Tools> Surface> Slope, use the clipped bathymetry AOI layer as the input 

raster, leave all another setting as default, click OK. This tool will output a layer presents the slope 

differentials within the AOI, see figure 13.  

Next, to import slope value and a depth value, we need to first convert them into point files. Go to 

Conversion tools> From Raster> Raster to Point, use bathymetry and slope layer as input raster, 

make sure the field selected is the one contains the real slope and a depth value, and convert them 

into point layers respectively. Then go to Analysis Tools > Overlay > Spatial Join.  

For this tool, we need to use the edge area and buffered center area as Target Features and use the 

slope and bathymetry point files we created as Join Features. And therefore create a total of four 

new layers, which are edge area with slope value, edge area with depth value, center area with slope 

value, and a center area with depth value respectively. Also, in Field Map of Join Features, we need 

to configure the properties by doing the following: in the Field Map of Join Features, find the one 

Figure 14. Result of combining edge buffer layer and center point buffer layer 



that contains the slope value/ bathymetry value, right-click on its name, and select properties. Find 

merge rule, select mean, and then click OK. By doing so, the depth/ slope value in each edge or 

center area will be the mean value of the entire area. Leave another setting as default and execute 

the Spatial Join tool four times.  

 

To compare the differences between the center area and the edge area, we need to join the 

attribute tables. Right click on the center area with slope value, select Join and Relates> Join. Choose 

the edge are with slope value in the second dropdown menu (This can be done another way around, 

aka use join function on edge area layer and select center area layer in the above step). In the first 

and third dropdown menu, select a field that is identical in both edge area and center area. In this 

case, I used the TARGET_FID for both. And click OK. Now when you open the attribute table of the 

center area with slope value, you can see that the slope value for the center area is joined in based 

on TARGET_FID.  

Next, add a new field called Slope_Diff using the add field tool. Right click on it (you will notice the 

name is longer than what you entered, which is expected because of the join), choose field 

calculator and deduct the slope value of the edge with the slope value of the center area. The result 

is that the new field is filled with the difference of slope value between the edge area and center 

area of each basin.  

Repeat the above step to calculate the depth difference. 

Figure 15. Slope value map for area of interest 



5. Overall Shape  
In this section, I will explain how I tested the “equidimensional” criteria in the oceanic basin’s 

definition using two different methods. 

First, equidimensional is an adjective applied to objects that have nearly the same size or spread in 

multiple directions. For a basin, it means that its length must similar to its width. With this 

knowledge, the first method we will use is the minimum bounding rectangle.  

Figure 16. Spatial Join Configuration 

Figure 17. Graphical illustration of different type of minimum bounding geometry 



The Minimum Bounding Geometry tool is located at: Data Management Tools> Features> Minimum 

Bounding Geometry. In this tool, we will use the basin polygon layer as the input feature, geometry 

type is rectangle by width. In addition, make sure that the box of “Add geometry characteristics as 

attributes to output (optional)”is checked. Otherwise, it will not produce the detailed measurements 

in the output layer. There are many types of geometry we can choose from. Figure 15 is a graphical 

depiction of them. We need to use the rectangle_by_width option, which draws rectangles with the 

longest line inside the shape as the width. The result will look like figure 17. 

In the result there will be a few new fields, among them, what we need is the MBG_Width and 

MBG_Length, which are the width and length of each rectangle. Next, in the attribute table, we add 

a new field called WLRatio, then use the field calculator to calculate the width to length ratio. The 

formula used should be [MBG_Width] / [MBG_Length]. The closer this output to 1, the more 

equidimensional the basin is. 

Although the width-length ratio method is directly based on the definition of “equidimensional”, it is 

not a perfect way of measuring. For example, the shape of the capital letter U or T can have a width-

length ratio very close to 1, but still not being equidimensional. To solve this issue, we need to 

ensure that basins with an irregular shape and a close to 1 width-length ratio can be detected. So I 

introduced a second method—the ideal circle area method.  

Figure 18. Minimum Bounding Geometry tool setting 



Mathematically speaking, a perfect equidimensional shape on a 2D surface is a circle since it has the 

universal diameter in any given direction. So what we need is to check the basin’s surface area 

compared to an ideal circle. To do so, I started by assuming the basin is a circle, and divide its 

perimeter by 3.14, to calculate the diameter of that hypothetical circle. Next, divide the 

MBG_Length value from the first method by the hypothetical diameter to produce an ideal circle 

ratio. Just like the minimum bounding geometry method, the closer the ratio to 1, the more likely 

that the basin is equidimensional. 

6. Fuzzy Logic 
After the above steps, we now have the following results: the edge to center slope differences for 

each basin, the edge to center depth differences, Length to width ratio, and the perfect circle ratio. 

In this step, we will use fuzzy logic to combine all four of them and produce a map of likelihood using 

fuzzy logic. 

To do so, we first need to convert the value in four maps into a standard format using reclassify 

function.  

First, we need to make four copy of the base basin layer. Right, click the basin polygon layer in the 

table of contents, select copy. Scroll up to find the layers, right click and select Paste Layer(s) for four 

times. Rename the four new copies as Basin with WL Ratio, Basin with Ideal Circle Ratio, Basin with 

Depth Diff, and Basin with Slope Diff respectively. Use the join function to import value for step 4 

and 5. Use the same method described in step 4 to introduce the value into the four new layers.  

Figure 19. Output of the minimum bounding geometry tool 



Next, we need to reclassify the value into several classes. However, the reclassify tool in ArcMap is 

for raster data only. To reclassify vector data, we need to do the calculation manually using the field 

calculator.  

We need to first use the built-in statistic tool to break the values into a few classes. To do so, right 

click on any of the four layers. Let’s use the width to length ratio as an example. Right click on the 

layer and select properties. Go to the Symbology tab. In the left panel, select Quantities, Graduated 

colors. For Values, we shall use the width to length ratio value. On the right side, click the Classify 

button. In the pop-out window, select Natural Breaks (Jenks) classification method, which is the 

method designed to determine the best arrangement of values into different classes. We want to 

form 6 classes. Click OK, and the data will be divided into six classes with the value labeled, see 

figure 18. Write them down or take a screenshot, these values are what we need for the manual 

reclassification. 

 

Figure 20. Natural Break data classification 

Next, right click on the Basin with WL Ratio layer, open attribute table, and add a new field called 

Reclass_WLRatio. Right click on the new field, and select field calculator. In the field calculator, 

choose VB Script parser, check the Show Codeblock box, and on the bottom, an extra box will show 

up, type x in that new box. In the Pre-Logic Script Code, use: 

if [WLRatio] <= 0.391867 then 

 x = 0 

elseif [WLRatio] <=0.521740 then 

 x = 1 

elseif [WLRatio] <= 0.643423 then 



 x = 2 

elseif [WLRatio] <= 0.731256 then 

 x = 3 

elseif [WLRatio] <= 0.826086 then 

 x = 4 

else 

 x = 5 

end if 

This will reclassify the width to length ratio into six classes from 0 to 5. Replace [WLRatio] with the 

field you need to reclassify and repeat above step for the rest three layers. However, for slope 

differences and depth differences, the classification will be a little different. We need to replace class 

0 to -10. And for that class, we need to put all the negative value in there. Because we want a way to 

get rid of the basins whose the center is higher or steeper than the edge so we give it a negative 

value instead of a low value.  

The last step is to add the value of the four layers together to make the final fuzzy logic map. To do 

so, use the join function to join the four-layer together base on the same field, such as the Id or the 

Objective field. And add the four reclassified field together as a new field called FuzzyLogic. 

Use the proper symbology setting to display the fuzzy logic value, we will get the final result. 

 

Figure 21. Fuzzy logic output, likelihood of being an undersea basin 

7. Result Interpretation and Future Application  
 

The final result is relatively easy to understand. Each polygon will be rated base on the four 

characteristics: edge to center depth differences, edge to center slope differences, width to length 



ratio and ideal circle ratio. The closer the final value to 20 (4*5), the polygon is more likely to be a 

basin base on B-6 definition. 

However, this is still a possibility distribution instead of a full automation. In my opinion, manual 

check is still needed. What we can do is to isolate the polygons with high fuzzy logic value (such as 

12.5 or higher) and pirortize on cheking them. Fugure 20 is an example of how the manual check can 

be done. 

 

 

Figure 22. An example of manual check for the 3 polygon with highest value within AOI 

According to the GEBCO undersea feature names gazetteer, currently there are 243 named basins 

around the world. In Canadian water, there are only 5-10 basins named (the number is an estimate 

based on visual check since GEBCO database does not allow user to do query base on national 

boundary). And all of them are fairly large ones.  

In other words, smaller Basins can be identified and named using this application. The result can be 

submit to IHO for review. And if the IHO accepted our proposal then we will improve our 

understanding of the Canadian seafloor; or, if the IHO rejected, then we can ask for more detailed 

reasons and help to refine the B-6 definition of basin and potentially other features. 

  



Appendix IV 

Undersea Ridges Identification 

Shenghao Shi  
This is a quick summary of my method of identifying undersea ridges using ArcMap 10.6. It is 
partially inspired by the article Geomorphology of the oceans by P.T.Harris et al. The main 
method is to identify elongated areas with high TPI (topographic position index) value and 
relatively large area. 
 
1. Open ArcMap, load the bathymetry file of the targeted area for analysis. 

The bathymetry file is the ETOPO1 dataset from NOAA, with 1 arc minute resolution  
2. Calculate the TPI value base on the bathymetry data. In ArcMap, there is no built-in tool 

that can be used to calculate TPI. Therefore I acquired the Land Facet Corridor Designer, 
v. 1.2.884 developed by Jenness Enterprises through their website. 
(http://www.jennessent.com/arcgis/arcgis_extensions.htm) this tool allows the user to 
generate a TPI layer based on DEM.  
After loading this tool into ArcMap, it will show up as a small window called Land Facet 
Analysis. Go to Land Facet Analysis> Topographic Position Index Tools> Calculate TPI 
raster. Use the bathymetry layer as the DEM raster layer, TPI type as the default. In the 
neighborhood options, select the desired neighborhood size and shape. In general, the 
larger the neighborhood, the Courser the final output will be. So the size should be 
controlled in a reasonable range. For my case, since my bathymetry has a coarse 
resolution (1 arc minute pixel size), chose a 3 cells radius.  

 
Figure 23. TPI raster layer with 50 cells radius 

http://www.jennessent.com/arcgis/arcgis_extensions.htm


  
Figure 24. TPI raster layer with 3 cells radius 
3. The Topographic Position Index (TPI) compares the elevation of each cell in a DEM to the 

mean elevation of a specified neighborhood around that cell. Positive TPI values represent 
locations that are higher than the average of their surroundings, as defined by the 
neighborhood (ridges).

 
Figure 25. TPI value and corresponding terrain types, Weiss (2001) 
4. Next, we need to reclassify the TPI to be able to identify the area with high TPI value. 

According to Weiss (2001), standard deviation is a repeatable method of creating classes. 
To be specific, ridge is usually considered to have TPI value higher than 1 standard 
deviation of the dataset (figure 4). 



 
Figure 26. Common classification breakpoints using standard deviation, Weiss (2001) 

 

The standard deviation of the 3-cell TPI layer is 31.58391919874432. I used this value as 
the threshold to reclassify the raster layer into two categories: ridges and non ridges. 
After 3D visual check using ArcScene against many known ridges in the GEBCO database 
and elevations that is very likely to be unnamed ridges, I believe this value can be justified. 
Figure 5 shows one example of checking this method against an real life example. The 
image on top is a screenshot from the GEBCO beta database, the red dot reperesnts the 
feature Eickelberg Ridge. The image in the middle is the TIP layer for the approximately 
same area. The image at the bottom is the reclassified TPI layer with threshold of 
31.5839192. This example showcased the 1 standard deviation indeed helps us identify 
elevation areas. 

  



 

 

 
Figure 27. An example of TPI based identifiaciton method 
5. After determin the breakpoint, we need to excecute the reclassification to remove all 

areas with TPI value lower than the threshold. Open the reclassify tool, set value below 



31.583919 to a new value (such as 1), set the rest to NoData, then execute. The result will 
be a raster layer with TPI value higher than 31.583919. 

 
Figure 28. Classifcation setting 
6. Next, we need to check the shape and only keep those linear shape features. First, use 

raster to polygon tool to convert the result from the last step into a vector file, then run 
the minimum bounding geometry tool, use the converted vector layer as input, use the 
RECTANGLE_BY_WIDTH as the Geometry Type. This tool will find the longest straight line 
within each polygon. Use that line as the width, draw a box around each individual 
feature. Be sure to check the Add geometry characteristics as attribute s to output box 
when using this tool. This option will add two fields called MBG_width and MBG_Length 
to the attribute table which we need for the next step. 

7. To determine the shape of the polygons, we need to calculate the width to length ratio. 
Open the attribute table, add a new field called WLRatio and set the type to float or 
double. Use the field calculator on the newly created field to calculate [MBG_Width] / 
[MBG_Length]. The larger the ratio it is, the more elongated the feature is. See figure 7. 

 
Figure 29. Length to width ratio illurstation. Shapes with higher ratio value tend to be more linear. 

 



8. Next step is to remove undesirable parts. Use select by attributes function to select 
features that have appropriate size and shape, which means Length to width ratio should 
be great than a certain number. In my case, it is 4. After all polygon with width to length 
ratio greater than 4 is selected, open the select by attributes function again. This time, 
use “select from current selection” method and select features larger than a certain size, 
in my case I used 30 km2. Next, right-click the layer and click Selection on the shortcut 
menu. Choose to create a layer from selected features to create a layer only contains 
polygons that fit all our requirements. 

9. Final Output 

 
  



Reference: 
Harrris, P.T. (2014). Geomorphology of the oceans. Marine Geology, Volume 352 (1), Pages 4-
24. https://doi.org/10.1016/j.margeo.2014.01.011 
Weiss, A. (2001). Topographic position and landform analysis. Poster presentation, ESRI User 
Conference, San Diego, California, USA. http://www.jennessent.com/downloads/TPI-poster-
TNC_18x22.pdf 
  



 

Appendix V 

Undersea Feature Identification Methodology - Sea Channel 

Shenghao Shi 

Shenghao.Shi@dfo-mpo.gc.ca 

Introduction 

This document summarizes the discovery methodology for sea channels based on the B6 

definitions. According to the IHO B-6 definition, a sea channel is: 

By reading the sea channel definition in B-6, we can tell that this feature has four key criteria: 

1) elongated, 2) meandering, 3) depression, 4) and occurring on a gently sloping plain or FAN. 

Part I & II are based on the key feature: depression, aka negative TPI value. Part III will focus 

on the other three: Elongated, Meandering, and Gently sloping/Flat. 

I. Hydrology Analysis  

The physical characteristics of sea channels resemble streams and rivers on land. They are all 

linear depression features that formed due to the erosion of water flow. Land channels are 

primarily the result of overland flow where saturation overland flow deepens to increase shear 

stress and begin channel incision (Bierman & Montgomery, 2014). While sea channels are 

“trough-shaped erosional features which occur on the deep ocean floor” (Shepard & Emery, 

1941). 

Draw upon the physical and developmental similarity of sea channels and land channels, we 

could utilize the hydrology toolbox in ArcMap to conduct our initial analysis. Detailed steps 

are: 

1. Add the bathymetry DEM into your ArcMap project.  

2. Run the fill tool on the DEM, name output “fill” 

To smoothen the DEM, therefore, produce better flow direction for hydrology analysis 

3. Run the flow direction tool, use the fill as input surface raster. 

This step basically assumes the raster surface is impermeable and outputs the direction of 

the flow for each cell base on its elevation differences compare to its neighbor cells. 

4. Run the flow accumulation tool, use the flow direction output from step 3 as input. 

5. Use reclassify or raster calculator to separate flow accumulation into two categories. I used 

the raster calculator, the expression "FlowAccumulation" >= 500. 

This will separate area with a high amount of flow accumulation with the rest, in other 

words, extract potential streams. 

In here I made an assumption of using 500 as the breakpoint for flow accumulation. 

Typically, a flow accumulation value should be no less than 100. Generally speaking, the 

smaller the threshold, the more noises will be included. Figure 1 below shows the 

differences between the threshold of 100, 300 and 500 in green, yellow and blue 

respectively. The reason for choosing 500 is that I checked the output against the existing 

An elongated, meandering depression, usually occurring on a gently sloping plain 

or FAN 

mailto:Shenghao.Shi@dfo-mpo.gc.ca


sea channels in the GEBCO database, 500 is the breakpoint that introduced a minimum 

amount of noise while ensured the integrity of the channels. 

There is an article on analytic method for determining an appropriate threshold value for 

stream network delineation by Tarboton, Bras, & Rodriguez-Iturbe (1991). More related 

research will be done on this issue in the near future to further decide a validated 

threshold. For purely methodology development, 500 will be used for now to reduce the 

amount of work. 

 

Figure 30. Flow accumulation threshold of 100, 300 and 500 in green, yellow and blue respectively. 

 

Figure 31. Flow accumulation reclassify result. Threshold = 500 



6. Next, use the stream to feature tool on the reclassified layer produced by step 5. 

This too converts a raster representing a linear network to features representing the linear 

network. 

7. Use the stream order tool, input stream raster is the output from step 5, again. 

8. Run the stream to feature tool again, this time use output from step 7 as input stream raster.  

The output is a polyline layer, which is our stream network for the AOI. 

9. The result from step 8 contains many segments. In order to make it easier to process, run 

the dissolve tool on it to produce a dissolved stream network layer. 

By this step, we have had the hydrology analysis completed. 

 

Figure 32. Identified streams 

 

By this step, we have identified potential stream network of the AOI. Some of the lines can very 

likely to be the centerline of sea channels. However, unlike a real drainage watershed, many 

of the streams are fictional. In order to remove ones that are not actual candidates of sea 

channels by comparing it with depression areas using TPI. 

II. TPI based primary identification of the potential sea channels  

In this part, we will identify depression areas using topographic position index. This method is 

partially inspired by the article Geomorphology of the oceans by P.T.Harris et al. (2014)  



10. To calculate the TPI value, we need to download a plug-in.  

I used the Land Facet Corridor Designer, developed by Jenness Enterprises through their 

website. (http://www.jennessent.com/arcgis/arcgis_extensions.htm) this tool allows the 

user to generate a TPI layer based on DEM.  

After loading this tool into ArcMap, it will show up as a small window called Land Facet 

Analysis. Go to Land Facet Analysis> Topographic Position Index Tools> Calculate TPI 

raster. Use the bathymetry layer as the DEM raster layer, TPI type as the default. 

In the neighborhood options, select the desired neighborhood size and shape. In general, 

the larger the neighborhood, the more generalized the final output will be. So the size 

should be controlled in a reasonable range.  

For this case, since this bathymetry has a coarse resolution (1 arc minute pixel size, roughly 

1.8 km * 1.8 km), chose a 3 cells radius, which translates to a TPI radius of 10.8km.  

Name the output TPI_3cells. 

11. The Topographic Position Index (TPI) compares the elevation of each cell in a DEM to 

the mean elevation of a specified neighborhood around that cell. Negative TPI values 

represent locations where its surrounding is higher than itself, in other words, depression 

areas. So we need to extract that area. 

 
12. Run the copy raster tool, set pixel type to 16_BIT_SIGNED. 

The purpose of this step is to convert the TPI layer into a signed integer type, which is 

required by the next step. 

13. Run the majority filter tool for the first time. This time choose four neighbors and 

replacement threshold as Majority. 

14. Run the majority filter tool for the first time. This time choose eight neighbors and 

replacement threshold as half. 

The purpose of step 13 and 14 is to remove the small imperfections in the TPI layer. 

15. Next, right click on the second time majority filter output, and change its symbology to 

Classified. Choose the quantile classification method and give it a large number of classes. 

Change the coloration of different classes and compare them to known sea channels. Find 

a threshold that will include the most part of existing sea channels while introducing the 

least amount of noise. 

This method begins by choosing a black and white color ramp, and change the color of 

low-value ranks to red one by one. In this case, the threshold is -8. According to Weiss 

(2001), the typical depressions are areas with a value less than 1 standard deviation. 

However, this does not apply very well in the discovery of sea channels.  

First, we shall look at a few known sea channels from the GEBCO database. By looking 

at figure 4, we can visually confirm that the three known sea channels have distinct TPI 

value compared to their surroundings.  



 

Figure 33. Known sea channels (represented by green pentagon) on TPI layer 

However, if we adopt the -1 standard deviation (in this case, -31.5), the result will be figure 5. We 

can tell that most of the sea channels are not properly represented.  

  



By gradually raising the TPI threshold value, we find out that a the value of -8 (represented by 

orange), the known sea channels are presented most properly. If we keep increasing the TPI 

threshold to -6 (represented by yellow), a significant amount of noise will be introduced. Thus -8 

was selected as the breakpoint for this analysis. 

Figure 34. TPI value of the AOI, dark red stands for value less than -31.5 



 

Figure 35. Reclassified TPI value of AOI with legend 

  

16. Base on the result of step 15, run the reclassify tool to reclassify the layer into two classes: 

one above -8 one below -8 



 

Figure 36. The result of step 16. Red areas= depressions 

17. Run the extract by attributes tool to extract part where TPI value is less than -8. 

18. Run the raster to polygon tool, use the result from step 17 as input, make sure to check the 

simplify polygon checkbox.  

19. Use the output from step 17 as input, run the buffer tool, buffer the layer so it can overlap 

with the streams we produced previously without break the streams into too many pieces. 

The buffer distance I used is 1500 meters. This is the optimum result I get by experimenting 

with different parameter settings, it does not include too much error while also effectively 

prevents breaking continuous lines into too many pieces. Consider the pixel size of this 

bathymetry data is 1800 meter by 1800 meter, as well as the general width of known sea 

channels (Carter, 1988),  is about 2-4 km for the floor, 4-8 km for shoulder, I believe this 

value is within a reasonable range. 

The purpose of this step is to prepare for the next step.  

20. Run the dissolve tool on the 1500 meter buffer to merge the layer into one single polygon. 

The purpose of this step is to reduce necessary breaks when clipping.  

21. Run the clip tool, use the dissolved stream as input feature (output of step. 9) and the 

dissolved 1500 meter buffer as clip features. 

In this way, all identified stream that is within 1500 radius of the depression area will be 

identified. Note: the result will produce one single feature that includes all line segments 

22. Run the multipart to singlepart tool to break the output from the previous step into 

individual line segments. 

23. Open the attribute table of the output of step 22. Add a new field called length_km, run the 

calculate geometry function to calculate the length in km. Then select the lines that are 



longer than 15 km, right click on the layer in the table of contents, go selection> create a 

layer from select features to remove the small segments.  

Now we have many individual segments with tiny ones (<15km) removed.  

This removal threshold of 15 km is justified by the data in Cater (1988)’s article. The 

minimum length of the known sea channel is 200 km and many of them exceed thousands 

of kilometers.  

Table 1. Summary of physical characteristics of deep-sea channels described in the literature. (Carter, 1981.) 

 
24. To break above line segments into individual pieces, the method is suggested by Richard 

Fairhurst. The steps are: 

1. Buffer the lines a very, very small amount and create a single feature (multi-

part polygon). 

2. Explode the polygon buffer into its separate parts to form polygons that cover 

only the lines that touch within the very, very small buffer distance. 

3. Calculate a long field in the polygons to be equal to the ObjectID of each 

exploded polygon. 

4. Use the Spatial Join tool with the lines as the target and the polygons as the join 

features. 

5. Dissolve the lines created by the spatial join output using the long field from the 

polygon that has the ObjectID of the polygon as the Dissolve field (Case field). Make sure 

the Create Multipart feature option is checked and the line ends option is unchecked. 

You will end up with every line that touches another line at any crossing or intersection of 

any kind will have merged into a single polyline feature. These polyline features will 

nonetheless be a multi-part line feature anytime a line crossing or 3-way or greater 

intersection exists. 

25. Next, repeat step 23, re-calculate the length, then remove small segments, this time use a 

larger threshold of 50 km. This is backed up for the same reason of step 23 

In this way (step 22-24) we will end up with line segments that do not have small pieces, 

has more than one endpoints, and with a minimum length of 50km.  

By this step, we have finished the stream analysis and the output of this step will be the 

potential sea channels.  



 
 

To summarize, Part I & II achieved the following: base on watershed analysis, find out 

areas with a high amount of fluid accumulation and consider them to be potential (sea) 

channels. Use TPI to identify significant depressions base on exanimate internationally 

recognized features. Merge two results to produce a layer of all potential channels that fit 

the word “depression”. 

Base on all of that, I suggest that “depression” should include a minimum sea channel 

bottom depth difference value compare with its flat (or a better word, smooth) (can be 

defined by 1. STD of DEM 2. STD of the slope. 3. Counter density 4. Local relief) the 

surrounding sea floor. 

 

III.  Criteria Analysis  

The sea channel definition in B-6 has four key criteria: elongated, meandering, depression, 

and occurring on a gently sloping plain or FAN. Part I & II is based on the criteria: 

depression. Part III will focus on the other three: Elongated, Meandering, and Gently 

sloping/Flat. 
26. First, we need to create a layer that represents the criteria Elongated.  

 

According to Carter (1988), the length of the sea channels varies from 200 to 3800 km. 

According to the manually digitized GEBCO sea channels, the length of the sea channels 

varies from 156 km to 739 km. 



The potential sea channels identified by so far have the maximum length of 1202.51 km, 

and a minimum of 15.05 km. 

Base on the above value, we can estimate that the minimum length of a sea channel should 

be no less than 150 km. 

 

27. Reclassify the result manually using the field calculator again. The method of this step will 

be needed for a few more times for reclassifying other criteria. 

1) This step is not necessary for reclassify length, but can help us to generate 

statistics quickly. Right click on the layer, go to properties, symbology, and choose 

Quantities> Graduated colors. Click on Classify, you will be able to classify your data 

with default functions. One that is commonly used is the Quantile method, it helps you 

to divide your data into several classes with an equal amount of data in each class. 

 

Figure 37. An example dividing data using classify function 

2) Open the attribute table of the layer, add a new field and give it a name of your choice.  

3) Run the filed calculator, check the Show Codeblock checkbox, type x in the box 

below, in the box above, use expression: 

 

if [field1] < value1 then 

x = 0 

elseif [field1] < value2 then 

x = 1 

elseif [field1] <= value3 then 

x = 2 

else 

x = 3 

end if 

4) In this way, you can reclassify your data in vector layers. For this reclassification, we 

need to divide the data into 2 categories: length greater than 150 km as “1” and length 

less than 150 km as “0”.  



Now, we have a field in the attribute table using 1 and 0 to differentiate whether the line 

segments reach the minimum length of 150 km or not. 

28. Next, we need to create a layer that represents the criteria Meandering. 

Run the minimum bounding geometry tool, use a copy of the result of hydrology analysis 

(a copy of the output of step 25) as input features, choose RECTANGLE_BY_WIDTH as 

the geometry type, be sure to check the Add geometry characteristics as attributes to output 

(optional) checkbox. Note the input layer’s coordinate system needs proper projection to 

ensure the right units are used. 

What it will produce is a minimum bounding rectangle for each line segments, which will 

contain the value of the width and length of that bounding rectangle. We will divide the 

actual length of the line with the length of the MBG rectangle. In this way, a straight line 

will have its length almost equal to the length of the rectangle, therefore a low number; 

while a more meandering line will produce a bigger result.  

 

Figure 38. Different types of minimum bounding geometry 

29. Right click on a copy of the output of step 25, go to Joins and Relates > Join. In the new 

Join Data window, choose ObjectID for the first box, choose the MBG output (step 28 

output) in the second box, choose ObjectID again in the third box. 

In this way, you will join the data from the MBG output and the output of the hydrology 

analysis together.  

30. Open the attribute table, add a new field called Lengthkm_MBGLength, run the field 

calculator tool and calculate the filed by dividing the length of the line in km with 

MBG_Length. 

The unit of MBG_Length will be the same as the linear unit for the input of MBG tool, 

scale up or down the value to make sure that MBGLength and Lengthkm are using the 

same unit. In this way, the result will be the River Sinuosity Index. According to Horacio 

(2014), the RSI measures the degree of meandering of a riverbed, which is further used to 

differentiate river types.  

 

31. Reclassify the result manually using the field calculator. For input details, see step 27. The 

classification breakpoints used are: <1.05 (straight); 1.05-1.3 (sinuous); 1.3-1.5 (moderate 

meandering) and >1.5(meandering form), which is suggested by Dr. Horacio (2014). Base 



on the suggest classifiers value and the observation result, I personally would suggest a 

Sinuosity Index greater than 1.3 should be used to quantify “meandering” in B6 definition.  

 

Figure 10. Potential sea channels, classified by sinuosity value 

Lastly, we need to calculate the criteria Gently sloping plain. Which means there should 

be a consistent slope value in areas around the line segments, either close to zero, which 

means very flat; or a consistent value, means it is sloping, but don’t have too much 

variation. 

Note: to define flatness, there are for ways I can think of, they are: 1) standard deviation 

of the DEM 2) standard deviation of slope value of DEM 3) Contour line density 4) local 

relief. The issue with method 1 and 3 is if the area surface is sufficiently smooth, but is 

tilting, then the larger the area, the less accurate they become. This analysis will focus on 

STD of the slope. More work on using local relief as the defining factor of flatness will be 

done in the future.  

32. First, run the slope tool on the bathymetry layer. Leave all setting as default.  

33. Run the focal statistics tool, use the result of the last step as input raster, neighborhood 

type as a circle, radius 3 cells, statistics type STD.  

This will generate a layer showing the standard deviation value of the slope base on a 3 

cells radius circle neighborhood. In other words, this is a flatness indicator.  

The standard deviation value basically stands for 1/6 of the variability in the selected area. 

For example, if a line segment’s surrounding area has an STD of 0.5, it means around 

68% of the slope variance will stay within 2 STD, aka 1°; about 96% of the slope variance 

will stay within 4 STD, aka 2°; about 99.8% of the slope variance will stay within 6 STD, 

aka 3°. 

Currently, we are still searching for literature and/or data for related descriptions of 

flatness to decide what STD value we should use as the threshold. 



 

Figure 11.Normal distribution. Each colored band has a width of one standard deviation. M. W. Toews - Own work, 
based (in concept) on the figure by Jeremy Kemp, on 2005-02-09 

34. Run the raster to point tool, convert the output of step 33 into a point layer. 

35. Run the buffer tool on a copy of the output of step 25, set the buffer distance to 20 km. 

The purpose of this step is to create areas that include area represents the surrounding of 

each line segments. The buffer distance of 20 km is chosen since it is large enough to 

include areas which are relatively extensive enough to negate the effect of small 

depressions or elevations to a certain extent. Also, it is small enough to not include areas 

that should not affect the local flatness. Although worth noticing, this value still has a 

certain level of arbitrariness.  

 

Figure 12. A close look at the coverage of 20 km buffer in the AOI 

36. Run buffer tool on a copy of the output of step 25. Set the buffer distance to 8 km.  



This step is aimed to create a buffer area that includes the floor and the shoulder of each 

sea channel. According to (Carter, 1988) and the manual measurement of digitized 

GEBCO sea channels, the common width of the sea channels varies from 5 to 15 km, with 

the minimum of 2 km and the maximum of 16 km. The 8km buffer will be created toward 

both directions, covering a maximum width of 16 km. Base on visual observation, the 8 

km buffer effectively depict the extent of the existing sea channels.  

 

 

Figure 13. A close look at the coverage of 8 km buffer. Upper: STD of the slope. Lower: TPI 

37. Run the erase tool, use the output of step 35 as input features, and use the output of step 

36 as erase features.  

This step removes the potential sea channels from the surrounding area. 

38. Run the spatial join tool, use the result of step 37 as target features, the result of step 33 as 

join features. In the field map of join features, find the field that contains the standard 



deviation value form the STD point layer, light click, go to prosperities, change merge rule 

to mean. Remove all other unnecessary fields by right click and delete them. 

This step will calculate the average standard deviation of slope value in each line features’ 

surrounding area. 

39. Open the attribute table of a copy of the output of step 25, go to Join and relates> Join. In 

the new Join Data window, choose ObjectID for the first box, choose the step 29 output in 

the second box, choose ObjectID again in the third box. 

In this way, you will join the slope’s average STD from the surrounding areas to each 

corresponding lines from the hydrology analysis.  

40. Reclassify the result manually using the field calculator. Method sees step 27.  

For the dividing threshold, based on observing of the bathymetry, the TPI layer, the slope 

standard deviation layer, and slope STD’s statistics. I divided them into 3 categories: less 

than 0.5, 0.5 to 0.65, greater than 0.65. These values have a certain level of arbitrariness. 

 

41. By so far, you should have 3 layers that represent the Elongated, Meandering, and Gently 

sloping/Flat criteria respectively. 

Use the join function, to join the three layers together. To remove repeated columns in the 

attribute table, right click on the layer and select Data> Export Data. The attribute table of 

the exported layer will be editable. 

 

42. Run selection> Select by attribute tool, use the joined layer as input, begin your selection 

using the method “Create a new selection”, then switch to “Select from current selection”. 

Use a proper formula to select features that: 

1) Longer than 150 km 

2) Have a sinuosity index of 1.3 or greater 

3) Have a slope standard deviation less than or equal to 0.5 

Right click on the joined layer, go to Selection> Create layer from selected feature to create 

a new layer represents the lines fits the above criteria. 

 

In this way, we have finished the identifying of features that fit all of our criteria.  

 

43. The output (count: 20): 



 

Figure 14.Output of potential sea channel where length>= 150 km, slope standard deviation <=0.5 sinuosity 
>=1.3 

44. There are certain possibilities that some potential sea channels are excluded when it fails 

to fit criteria by a small amount. In order to not overlook potential channels, we want to 

go back to the first criteria: depression.  

Run raster to point tool, convert the TPI layer into point format.  

45. Run spatial join tool, use a copy of joined layer from step 41 as target feature, TPI point 

layer as join feature. Choose WITHIN_A_DISTANCE_GEODESIC as the match option, 

with a search radius of 950 meters. Make sure the merge rule is mean. 

Since the target feature is line feature, and our point layer has a pixel size of 1 arc minute 

(1.8km by 1.8km), searching points within the distance of half of the pixels’ side length 

allows the algorism to collect values along the line. 

46. Change the symbology of the layer to Quantities> Graduated colors. In the classification 

setting, manually insert the value of -1 STD. In my case, the value is -31.5, round up to -

32, which happen to be the minimum break value for my area of study. The result is shown 

in figure 15. According to Weiss (2001), -1 STD can effectively represent depressions. 

Thus, we want to make sure these profound depressions are not ignored.  



 

Figure 15. All potential sea channels reclassified by average TPI value 

47. Use the join function, to join the TPI layers with the previous joined layer.  

48. Run selection> Select by attribute tool, use the joined layer as input, begin your selection 

using the method “Create a new selection”, then switch to “Select from current selection”. 

Use a proper formula to select features that: 

1) Has to mean TPI value less than -32 

2) Longer than 150 km 

3) Have sinuosity index of 1.15 or greater 

4) Have a slope standard deviation less than or equal to 0.65 

49. Right click on the joined layer, go to Selection> Create layer from selected feature to create 

a new layer represents the lines fits the above criteria. 

50. The output (count 8, 1 overlaps with the output of step 43): 



 

Figure 16. Output of potential sea channel where average TPI < -32, length>= 150 km, slope standard 
deviation <=0.65 sinuosity >=1.15 

51. Overlay the result of step 43 and 50: 

 

Figure 39. Methodology final output, identified potential sea channels 

  



IV. Testing against GEBCO Database 

In the SCUFN beta gazetteer, sea channels are categorized as “sea channel”, “seachannel” or 

“channel”. All of them can be found by word search on “channel”. Both sea channel and 

channel are generic terms recognized by B-6, however, seachannel with no space in between 

is irregular usage of the term. 

 

Figure 18. Known sea channels in the area of interest. Source: SCUFN beta gazetteer 

The search within the area of study returns with 13 results, highlighted by red color. The 

existing features are presented with a single set of coordinate or a straight line, defined by a set 

of the coordinate of the start point and end point. Neither is a highly accurate way to depict of 

a sea channel. There is uncertainty I want to address: when a sea channel is shown as a single 

point, we do not know whether that is the start point, midpoint or end point. 

 

The validation result is: 5 features are successfully identified; 1 feature might be identified; 7 

features are not identified. As shown in figure 19. 

 

First, the feature we could not confirm, the one marked as a question mark in the Gulf of Alaska 

is called Surveyor Sea Channel. Figure 20 shows a closer look at the area. If the coordinate in 

the SCUFN gazetteer marks the endpoint of the sea channel, then the feature our method 

detected on its east have a high possibility to be the Surveyor Sea Channel. If the coordinate is 

the center point of the feature, then our method did not pick it up. 



 

Figure 19. Validation result, methodology output vs SCUFN beta gazetteer. Red star = identified, Blue question 
mark = cannot confirm, Black = not identified 

 

Figure 20. A closer look at the Surveyor Sea Channel, coordinate represented by a green dot, red lines is identified 
sea channels nearby. 

Next, we checked the 7 features we failed to detect, the result reveals a different issue. 

In all 7 locations, the seafloor bathymetry does not show anything resemble a sea channel. See figure 

21 and 22. 



 

Figure 21. Existing sea channels' relative location on bathymetry. Feature name from left to right: Horizon 
Channel, Mukluk Channel, Moresby Seachannel 

 

Figure 22. Existing sea channels' relative location on bathymetry. Feature name from left to right: Sagittarius 
Seachannel, Aquarius Seachannel, Taurus Seachannel. 



Our understanding toward this matter is that since sea channels are formed due to erosion effect caused 

by ocean floor current, unlike streams and rivers on land, the flow direction ocean current can vary 

relatively easily. Therefore, certain undersea features including sea channel that does not consist of 

solid material, could be potentially covered by sediment therefore disappear on bathymetry. The sea 

channels can still be visible on another type of data such as seafloor material composition. 

Note1: Sagittarius Seachannel, Aquarius Seachannel, and Taurus Seachannel were all proposed to 

SCUFN more than 40 years ago on the 6th SCUFN meeting in 1985. 

https://www.iho.int/mtg_docs/com_wg/SCUFN/SCGN1_to_SCUFN14/SCGN06_report_1985.pdf 

 

Note2: According to SCUFN report, SCUFN21-09.2B, Horizon Channel and Mukluk Channel’s 

validity has been questioned in the SCUFN 21, May 2008. This documents supports our validation 

methodology.  

https://www.iho.int/mtg_docs/com_wg/SCUFN/SCUFN21/SCUFN21-

09.2B_Proposed_changes_in_GEBCO_Gazetteer_Part2.pdf 

 

Note3: Moresby Seachannel was used as the example for sea channel in the SCUFN21-04.1A. 

https://www.iho.int/mtg_docs/com_wg/SCUFN/SCUFN21/SCUFN21-04.1A_B6_EF_2008.pdf 

 

Lastly, visual check for successfully identified sea channels confirmed that all the identified features 

have the general shape and size that fits the B-6 definition. 

 

In conclusion, we are confident to say that: 

1) Our method tool is capable of discovering new sea channels base on the B-6 definition. 

2) Some existing Sea Channels/ Channels could not be identified using bathymetry only. 

3) The B-6 definition needs an update to properly function as official definition, and based on 

our analysis, we suggest a new definition for sea channel as follow: 

  

A meandering linear depression with sinuosity typically greater than 1.3, at least 

no less than 1.15. Feature need to be no shorter than 150 km, usually occurring 

on a gently sloping plain or FAN where local slope standard deviation is typically 

less than 0.5 degree, at least no more than 0.65 degree. 

https://www.iho.int/mtg_docs/com_wg/SCUFN/SCGN1_to_SCUFN14/SCGN06_report_1985.pdf
https://www.iho.int/mtg_docs/com_wg/SCUFN/SCUFN21/SCUFN21-09.2B_Proposed_changes_in_GEBCO_Gazetteer_Part2.pdf
https://www.iho.int/mtg_docs/com_wg/SCUFN/SCUFN21/SCUFN21-09.2B_Proposed_changes_in_GEBCO_Gazetteer_Part2.pdf
https://www.iho.int/mtg_docs/com_wg/SCUFN/SCUFN21/SCUFN21-04.1A_B6_EF_2008.pdf
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Appendix VI 

Shelf and Slope Break Detection  
in ArcMap 
Erin Turnbull | June 25, 2019 

Introduction 
The IHO B-6 document “Standardization of Undersea Feature Names” provides definitions for 

generic terms used to classify undersea features. For shelves, this definition is as follows: 

The flat or gently sloping region adjacent to a continent or around an island that 
extends from the low water line to a depth, generally about 200m, where there is a 
marked increase in downward slope (IHO 2017). 

 

From this definition, it is clear that the key to identifying a shelf is to first locate the shelf-break, 

which is the line at which there is a “marked increase in downwards slope” (IHO 2017). The shallow 

area between the shelf-break and the shoreline is then the “shelf”. 

Methodology 
One method for locating the shelf-break is to look at contour density (Harris et al. 2014). Harris et al. 

manually determined the location of the seaward boundary of the shelf based on a manual 

inspection of the spacing of contour lines, referred to here as the “contour density”. They 

determined that in most cases, the 100 m contour lines were sufficient; however, some areas 

required more detailed contour lines. 

This approach adapts Harris et al.’s approach by developing a metric for contour density based on 

the shelves of Atlantic Canada, as classified by GEBCO. This approach works off of raster data. Raster 

“contour lines” are constructed by rounding each cell down to the next lower contour interval. For 

example, if contouring at -100 m, depths of -1 to -100 would be classified as “-100”, depths of -101 

to -199 would be classified as “-200”. The minimum value of the 3x3 grid surrounded each cell is 

then calculated. Cells that have a different value from the minimum are part of the raster contour 

line. 

Contour density is calculated as the difference between the maximum and minimum rounded values 

within a certain radius, divided by the contouring interval. Contour density is only calculated on cells 

that are part of a contour line; this forms a raster where each cell on a contour line has a value equal 

to the number of contour lines within the radius. This assumes that contour lines are a fairly good 

representation of the boundaries of the slope. Based on an analysis of Atlantic Canada, these cells 

are then reclassified by contour density into “Yes”, “Maybe”, and “No”. Cells not part of the contour 

lines are assigned a “No” value. Exact values for these parameters follow in the next section.  

The slope is also typically steeper on the continental slope. Since contour lines are only an 

approximation of the beginning of the slope, this information is supplemented with the slope of 

each cell using the Slope tool. The slope values are also reclassified as “Yes”, “Maybe” and “No”. 



The slope and contour density reclassifications are then combined, with the slope logical value 

taking the place of the contour density value where ever the contour density is “No”.  

This data is cleaned up slightly using a Majority Filter, which replaces the cell if half or more of its 

eight neighbours disagree with its value. This eliminates small errors in the data and should be ok, as 

the continental slope is a broad feature. The “Maybe” cells are then assigned to be either “Yes” or 

“No” based on which is closer, using the Shrink tool.  

The resulting data is run through the Boundary Clean tool, which makes slightly nicer edges on the 

shape and cleans up tiny spots. The end result is a fairly good representation of extensive sloping 

areas on the map, but it includes many areas that do not represent the continental slope. 

By definition, the continental slope is the transition between the shelf (typically < 200 m) and the 

deeper ocean (> 3000 m). To identify these transitional areas, the results are grouped by region 

using Region Group and the minimum and maximum depths are calculated. In order to qualify as a 

continental slope, the region must transition from shallow enough water to deep enough water. 

The last step for the slope is to convert qualifying regions into polygons. Small gaps are filled in these 

polygons using the Union and Dissolve tools, as the slope should be a contiguous area. 

To identify the shelf, cells that are not part of the slope are also region grouped. The shelf must 

touch the shoreline, so regions with a shallow enough minimum depth are counted as part of the 

shoreline. In addition, the region cannot extend to too great a depth, otherwise it is not a shelf any 

more. These regions are also eliminated. The remaining cells are turned into polygons using the 

same process as for slopes. 

Parameterization 
The methodology requires several key parameters. These values have been chosen based on what 

provides appropriate results for Atlantic Canada; however, these values may not be suitable for the 

entire world. Further adjustments need to be made based on a broader review of the results. 

Parameter Value Rationale 

Contour Interval 50 m Harris et al. (2014) discuss the need to use 50 m contours, 
and even 10 m contours, in certain locations. 50 m contours 
are fairly quick to produce, so this is the value chosen for 
now. Some areas may require finer detail. 

Contour Radius 15,000 m These values were chosen based on an examination of the 
Atlantic region. 8 50m contours over 30,000 m corresponds 
to an average slope of about 1.33% or 0.76°. The shelf is 
typically under 0.5°. The “Maybe” cutoff is just below to 
ensure the nearby contours are included. 

Contour Density – 
Maybe Cutoff 

7 

Contour Density – Yes 
Cutoff 

8 

Slope – Maybe Cutoff 0.5° As mentioned above, shelves are typically under 0.5°. 
Values above 1° are therefore likely steep enough to be 
part of the slope, if positioned correctly. Intermediate 
values will depend on their proximity to steeper or denser 
areas. This is based on a visual examination of the slope 
values near the dense contours. 

Slope – Yes Cutoff 1° 

Continental Slope 
Required Shallowness 

-250 m The continental slope is connected to the shelf, which 
typically has depths of up to 200 m (IHO 2017). This value is 
chosen to be slightly deeper to be sure that the slope itself 
is included. 



Continental Slope 
Required Depth 

-1000 m This depth was chosen to ensure that the slope exits the 
mesopelagic zone. While slopes and rises tend to go much 
deeper, those depths may not be on the map.  

Shelf Nearshore Depth -2 m A shelf is defined as needing a cell at least this depth or 
shallower. -2 was chosen as rounding errors near the shore 
sometimes caused the shelf to not be picked-up correctly 
(i.e. there was no -1 cell).  

Shelf Maximum Depth -1000 m This depth was chosen to ensure that, if the slope could not 
be found, a shelf was not accidently selected. Shelves are 
typically shallower than 200 m, so they definitely should 
not extend this deep.  

Discussion 
In terms of meeting the B-6 definition, this approach mostly meets the existing criteria. By defining 

“marked increase in downwards slope” to mean “a change in contour depth of at least 400 m per 30 

km or a slope within a cell of over 1°”, this provides a quantitative evaluation of the changing 

regional-scale slope over distance. One part that is not met is that it must be a “downwards” change 

in slope. Typically, there are no “upwards” changes that meet the parameters chosen, but 

“downwards” could be detected by looking only in the 180° wedge away from the direction of the 

closest 0 contour to each cell. However, this would take significant extra processing power to 

determine the direction of the nearest shoreline. The “flat or gently sloping” part is also not handled 

at the moment, as the contour density generally takes care of that. However, it should also be 

reviewed if more steeply sloping areas need to be excluded. 

This approach assumes that all slopes that span the mesopelagic zone are continental slopes. This 

may not be a good assumption, but it is fairly likely true. Since shelves are also required to be 

shallow enough, an extraneous slope does not impact the identification of shelves.  

The advantage of using contouring as the main method for feature detection is that it follows what is 

typically done today to identify features. Rarely do humans examine a raster of depths to identify 

features; as Harris et al. (2014) discusses, contours are commonly used in the manual identification 

of features. A contour-based process therefore has the advantage of being relatable and easy to 

confirm on an actual map.  

However, this definition does not meet the UN’s definition of the continental slope (United Nations, 

1982), which is based on the thickness of crustal sedimentary rock. Therefore, this technique should 

not be used for legal interpretations of the location of the slope. Alignment of the B-6 definition with 

the UN definition is one potential strategy, though the thickness of sedimentary rock cannot be 

determined by bathymetry alone. 

All of the parameters assumed here have been chosen through examination of one area of the shelf 

in Atlantic Canada. Both the technique and the parameters should be verified and refine by 

comparing the results to the literature and to existing continental shelf polygons throughout the 

world. 

Proposed Refined B-6 Definition 
Based on this work, a refined B-6 definition could be proposed as follows. Here, the values from the 

Parameterization section have been inserted; these need further review as per the Discussion 

section. 



Shelf Break: 
A line defined by the shoreward boundary of an area which deepens at a rate of at least 
400 m per 30,000 m away from shore or has a localized slope of at least 1°. It may 
include adjacent areas which deepen at a rate of 350 m per 30,000 m or have a 
localized slope of at least 0.5°. It must span depths from 250 m to 1,000 m. 
 
Shelf: 
The flat or gently sloping region adjacent to a continent or around an island that 
extends from the low water line to the shelf-break. 

Conclusions 
Here, I have presented a method for finding shelves based on an analysis of contour density on 

raster bathymetry files. The technique meets most of the current B-6 definition and suggests a 

refined definition that specifies what a “marked increase in downward slope” defines. 
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